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Please Note:  Meetings will now be  on the second 
Tuesday of each month.  Starting at 3:00 P.M.  
 
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade TN 

.  
 
   

What’s New in Personal Income Taxes 
 

Bob Willis, a long-time tax preparer and 
one of our club Directors, will be the  
presenter this months. 

 
There are no major federal tax changes for 
2021, but there are several significant fu-
ture changes being debated in Congress. 
Tax rates are unchanged for 2021, but 
brackets and standard deductions change 
annually. The Required Minimum Distribu-
tion (RMD) from IRAs for seniors over age 
72, has returned, and your tax return can 
make-up any missed 2021 Stimulus pay-
ments. Take extra care reporting the stimu-
lus money you actually received in 2021 to 
avoid lengthy delays in receiving your tax 
refund.  The same can be said about the 
substantially increased 2021 Child Tax 
Credit. Families with children under the 
age of 18 could get 50% of the credit pre-
paid during the year, but errors in reporting 
the advance amount received could also 
delay your refund.  
Finally, the Tennessee (Hall) Tax on in-
vestment income was completely phased 
out last year and is now just history. 
 
These are just the highlights of the tax top-
ics that will be addressed in the meeting. 
.  
 
 

Monday, February 14, 2022 

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of 
the SIG meetings as a guest will be charged $3.00 per per-
son for any or all meetings in that month. Afterwards, you 
are encouraged to become a member of the Plateau PC 
Users Group.  Our Club cannot exist without you, the 
members.  
  
Membership Dues  
Our annual dues are now payable July 1st. of each year.  
Annual  dues are $24 per single person / $30 per family.  
Persons/families joining during the fiscal year have dues 
payable as follows: 
 

 
 

 
BOARD OF DIRECTORS DISCLAIMER 

All members of the Plateau PC Users Group are willing 
to help one another in the area of advice and tutorial in-
struction over the phone.  If you should require more in-
volved services or instruction, we have a few members 
who are very knowledgeable in several areas.  As a re-
sponsible  
consumer, it is up to you to discuss, before retaining a 
member, any and ALL charges for repair services and 
time consuming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees 
for individuals for services rendered, nor the responsibil-
ity to intervene between members who enter into a con-
tract among themselves. 
 
The GAZETTE is published using the following:  Mi-
crosoft Word, Microsoft Publisher, and Microsoft Win-
dows.  The Gazette is the monthly newsletter of the Plat-
eau PC Users Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is 
made by the PPCUG, the Gazette editorial staff or its 
contributing editors.  This extends to all losses incidental 
or consequential from the use or non-use of any infor-
mation in any issue of the Gazette. 
 
All images used in the newsletter, website, blogs, class 
materials or handouts (“media”)  are obtained from a “free 
use” source, preferably images that have been released as 
“CCO Public Domain”. 

 
 
 

 

2021-2022 PPCUG, Inc. Board Members 

 Join In 
July - 
Sept 

Oct - 
Dec 

Jan - 
Mar 

Apr - 
June 

Single $24 $18 $12 $6 

Family $30 $22 $15 $7 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
 

Charlie Merrick (931) 210-8013  

Treasurer John Krueger (931) 707-3677 

Acting Secretary Richard Del Frate (931) 456-2251 

Past President Carl Nordeen  (931) 456-5597 

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

Directors at Large 

Gordon Botting Jim Buxton   Richard Del Frate 

Barbara Duncan Bob Willis   

   

Printed by, Business Equipment Clinic 
539 West Ave. Suite 101  Crossville TN 38557 
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** Visit the PPCUG Website ** 

At: www.PPCUGinc.com. 
 
Read all about our club activities and scheduled monthly meetings, also current and past issues of the  Gazette 
Newsletter. Links also to the Meeting Handouts on past presentations. 
 

Send your comments and suggestions to the PPCUG Webmaster, Alan Baker 
jackal33980@gmail.com  (931) 239-0877 

Cool Tips and Sites 

 
Microsoft Word 

Adjust the Page Layout with Margins 
 

Margin adjustments are one of the top tips and tricks of MS Word. Margins control how close text comes to 
the edge of your page. By adjusting them, you can transform how your Word doc looks. 
 
Margins live on the Layout tab. Click Layout, and you’ll see a Margins dropdown menu. Click it. 
 

 
 
Control how text fits on a page by making adjustments on the Margins menu in Word. 
 
Normal margins are the default. The Normal setting is 1 inch of spacing on all four sides of your page. 
You’ll see some other preset options, like Narrow, Moderate, and more. You can create your own custom 
margins by clicking Custom Margins at the bottom. 
 
On the Document window, you can add your desired settings. Click OK when you’re finished. This is one 
of the best Word tips and tricks 
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Cutting the Paper 
My Personal Features Page 

By Tom Burt, Vice President 
Sun City Summerlin Computer Club 
https://www.scscc.club  tomburt89134 (at) cox.net 
 

Here in Sun City Summerlin (Las Vegas), the local paper is the Las Vegas Review Journal. When Mrs. 
Burt and I first moved here about 21 years ago, the "RJ" was a substantial paper with lots of news, features, 
and editorial content. We had a 7-days a week subscription, and the morning read was a regular part of our 
day. 

 

As time passed and the paper changed hands, the price steadily crept up, the physical size of the paper grew 
smaller, and the page stock thinner. The news content also diminished, and the quality of the writing suf-
fered. In simple terms, we were steadily being charged more for less. 

 

Also, as we grew older and less spry, going out in the morning to retrieve the paper from our steep drive-
way became an onerous chore – especially in the chilly winter months. And, of course, all that paper was 
going right back into the recycle bin – especially on Sunday when we would pretty much toss all the ex-
pensive color ad supplements. 

 

About two years ago, when the renewal price went over $153.40 a year, we decided to cancel the "RJ" and 
get our news from the Internet and the TV. We've never regretted that decision. However, we did miss the 
comics and features. So, my inner geek decided to do a little work to locate replacements on the Internet 
and assemble all of the hyperlinks onto a simple, personal web page that I can launch from my Windows 
desktop. 

 
Comics 
Two major comics services offer a large selection of free comics. These are: 

 

https://gocomics.com and https://comicskingdom.com. I also link to https://dilbert.com to get the daily and 
Sunday Dilbert comics by Scott Adams. You can search or browse these sites and then save the links to 
comics you like. All these comics, even the dailies, are in color, and you can scroll back in time if you miss 
a few days. 

 
Sports Sites 
I have links to most major sports websites like https://PGAtour.com, https://NFL.com, and so on to check 
standings, schedules, and major sports news. I'm mainly a golf, football, and auto racing fan, but you can 
link to any sites you like. 

 

 

(Continued on page 5) 
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Puzzle Sites 
I have links to several crossword puzzle and word game sites. My favorite is the AARP daily crossword – 
hard enough to be challenging, easy enough to be done in 10 minutes or less, and they time and score you. 
About once a week, I can score a top 1890. 

 

Other Handy Sites 
I have a link to the Old Farmer's Almanac website to get astronomical data and other news. I have a link to 
the Review Journal's website so that I can check local news headlines. I have links to the local supermarket 
websites where the weekly food pages are online. And I have a link to the https://www.TitanTV.com website 
with the schedules for DirecTV in Las Vegas to check schedules for TV programming. And I have a link to 
https://ZDNet.com to check on Computer and Technology news. 
 
How to Do Your Own 
Here's what my "Personal Features" web page looks like in my web browser: 
 

 
 
I used a simple two-column table to organize the content. Then, when each link is clicked, it opens the target 
page in a new browser tab. That makes it easy to view all the comics without hitting the back button after 
each one. 
 
Editing the Features Page 
Since I'm also our club's Webmaster, I have some fairly powerful software tools for web page editing – nota-
bly Microsoft Expression Web 4 and Visual Studio 2019. Both of these can be downloaded for free at 
https://Microsoft.com in the Downloads section. However, these tools, while relatively easy to use, do re-
quire some learning. 
 
If you have MS Word or LibreOffice Writer, you can open an existing HTML document or create a new 
document and save it as HTML. In the document, you can use any layout or organization that appeals to you. 
You could even use images in place of or along with the link titles. 

(Continued from page 4) 

(Continued on page 6) 



 
Gazette February 2022                               www.PPCUGinc.com                                                  Page 6  

 
The key actions to create a new link are: 

1. In your web browser, browse to the website or comic you wish to link to. 
2. Copy (Ctrl+C) its hyperlink from the address bar of your browser to the clipboard. 
3. In the web page editor (e.g., Expression Web 4), type in the comic's name or feature into a new line 

on the web page. 
4. Select that block of text and right-click. 
5. From the popup menu that appears, choose "hyperlink" or "edit hyperlink" (depending on your edit-

ing tool). 
6. A hyperlink editing dialog will appear, displaying the text you highlighted in the "Text to display" 

box. 
7. Paste (Ctrl+V) the copied actual hyperlink into the "Address" box in the dialog. 
8. Click the Target Frame button. A secondary dialog will open (see below). Choose "New Window" 

from the list. If it's enabled, check the box to set that option as the default for all other hyperlinks on 
your features page. Then you won't need to set the target frame on each link you create explicitly. 

 

 
 
MS Expression Web Hyperlink Editor 
 

 
 
MS Expression Web - Target Frame Dialog 
The hyperlink dialogs are similar if you're using MS Word or Libre Office to edit your Favorites page. 
 

(Continued from page 5) 

(Continued on page 7) 
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You can also change the fonts, colors, and highlighting effects on the page and links to suit your preferences. 
 
Conclusions 

For us, cutting the paper wasn't about saving money; it was about not getting VALUE for our money and 
about convenience. It was also in a small way about saving some natural resources by eliminating paper; 
even though the used newsprint is supposedly recycled, a lot of it isn't. 

 

The Internet is a vast resource for news and entertainment of all kinds, with much of it free (admittedly with 
ads, but you can ignore those). So my selection of comics features is very modest – just enough for about 
half an hour a day. And what's great is they take up no space and don't have to be toted out to the recycling 
bin and thence to the curb once a week. 

 

Even if you decide to keep your subscription to the local paper, you may want to set up a features page like 
mine. The RJ's selection of comics wasn't the best. The ones on my page are ones I enjoy. 

    

 

How to Print a Google Calendar 

SANDY WRITTENHOUSE 

Not everything needs to be digital these days. If you want to print your Google Calendar to pop a month’s 
schedule on the fridge for your family or a week’s schedule to hand your childcare provider, it’s easy to do. 

You can print a day, week, or month of your Google Calendar along with the schedule and custom views. 
You can also select specific dates, which is handy for a travel itinerary or a convention you’re attending. 

Table of Contents 
Option 1: Print a Day, Week, Month, or a Custom View in Google Calendar 
Option 2: Print a Schedule in Google Calendar 
Print Your Google Calendar or Schedule 

Option 1: Print a Day, Week, Month, or a Custom View in Google Calendar 

Visit the Google Calendar website, log in if necessary, and mark the calendars on the left if you have more 
than one. 

(Continued from page 6) 

(Continued on page 8) 
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To print a month, select “Month” in the view drop-down box at the top of the main Google Calendar screen. 
If you have a custom view set up, like a five-day view, select it in the drop-down box. For a day or week, 
you can select one of these views using the drop-down box or choose one of the other views and adjust it to 

Day or Week on the Print Preview screen. 

 

 

 

 

 

 

 

 

 

Click the gear icon to the left of that to view the Settings Menu and choose “Print.”

 

On the Print Preview screen, you’ll see that the View is set to Auto. This means that whichever view you 
choose on the main screen is the one you’ll see here by default. However, you can change it to Day or Week 
in the View drop-down box for those options. 

 

(Continued from page 7) 
 

(Continued on page 9) 
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Above the View, pick the Print Range for the dates you want to print. As you adjust this range, you’ll see 
the number of pages included over the preview. 

 

Next, you can choose a different Font Size to make the text on the printed piece larger or smaller. You can 
also select Portrait or Landscape for the Orientation which is set to Auto by default. For Color & Style, you 
can pick from Outline, Full Color, or Black and White depending on your preference. 

 

At the bottom of the print settings, you can check the boxes to Show Weekends and Show Events You 
Have Declined if you wish to include these on the printed calendar. 

 

RELATED: How to Print a Google Doc With Comments 

Option 2: Print a Schedule in Google Calendar 

(Continued from page 8) 

(Continued on page 10) 
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Alternatively, if you have a particular schedule of events that you want to print, you can do so with some 
additional options beyond those above. 

Select “Schedule” in the View drop-down box at the top of the main Google Calendar screen. Then, click 
the gear icon to open the Settings Menu and choose “Print.” 

 

On the Print Preview screen, you’ll see a few of the same settings as with the above views. You can select 
the Print Range for the dates, choose a Font Size, and pick a page Orientation. You can also Show Events 
You Have Declined and print in Black and White. 

 

Along with these settings, the Schedule view gives you More Options at the bottom. You may way to print 
the descriptions of the events, the end times, the attendees, and your responses to the invitations. Simply 
check the boxes for those options you’d like to include. 

 

(Continued from page 9) 

(Continued on page 11) 
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Print Your Google Calendar or Schedule 

Once you select the view and adjust the print settings and options, click “Print” at the bottom of the screen. 

 

Depending on the browser you’re using and your settings, you may see the calendar open as a PDF file or 
have the option to print immediately. Simply follow the prompts to print your calendar. 

 
 
 

How to Insert the Cent Symbol With a Keyboard Shortcut in Microsoft Word 

MAHESH MAKVANA 
 

 

If you need to insert the cent symbol (¢) in your Microsoft Word documents, the fastest way is to use a 
keyboard shortcut. We’ll show you how to do that on Windows 
. 
Insert the Cent Symbol in Word on Windows 

(Continued from page 10) 
 

(Continued on page 12) 
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On Windows, you have two keyboard shortcuts to add the cent symbol to your documents. Use the first 
shortcut if your keyboard has a numeric keypad, or use the second shortcut if it doesn’t. A numeric keypad is 
a keypad with numerical values (0-9) usually found to the right of your keyboard’s main keys. 
 
Add the Cent Symbol With Numeric Keypad 
 
Start by opening your document in Word and placing your cursor where you want to insert the cent symbol. 

 
Then, on your keyboard, press and hold down the Alt key while typing 0162. 
 
Warning: Do not use the numbers row at the top of your keyboard to type 0162. That won’t work. You must 
use the numeric keypad on the right of your keyboard. 
You will see the cent symbol in its desired place in your document 

 
Add the Cent Symbol Without a Numeric Keypad 
Open your Word document and place the cursor where you want to add the cent symbol. 
 

 
On your keyboard, press and hold down the Ctrl key and then quickly press /C (a forward slash followed by 
the letter C). 
The cent symbol will appear in your document. 

 
And you are all set. 
 

(Continued from page 11) 
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How to Scan Photos and Documents Without a Scanner 

JOE FEDEWA 
  @tallshmo 

  
 

Scanners had their moment, but nowadays it’s not as necessary to own one. However, that doesn’t mean 
you never need to scan a document or photo. Thankfully, you probably have some tools to do it without a 
scanner. 
 
If you find yourself scanning a lot of documents and photos, it’s a good idea to invest in an actual scanner. 
Most people only need to scan a few things a year, so we’ll show you some good alternatives. 
 
RELATED: How to Scan a Document in Windows 10 
 
Smartphone Camera 

 
A scanner is essentially just a camera that takes a photo of your document in a very specific way. Well, 
you carry a camera in your pocket every day, so why not use that as a scanner? 
 
The truth is a smartphone camera is usually perfectly fine for getting the job done as a scanner. The results 
won’t be as crisp and clear as an actual scanner, but it will get the point across. Here are a few suggestions 
for taking good photos of a document. 
 

· Lighting: Place the document on a flat surface with good lighting. Try to avoid casting a shadow 
on the document with your hand and phone. 

 
· Placement: Take the photo straight on to avoid any weird angles. This can be done from directly 

above or at a right angle by propping up the document. Do whichever results in the best lighting/
fewest shadows. 

 
· Framing: Make sure to take the photo from far enough away so the entire document is in view. 

After you take the photo, crop it to the document so you don’t see any of the surroundings. 
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Accuvoice V100 "Mini" TV Speaker 
 

By George Harding, Treasurer, Tucson Computer Society 
https://aztcs.apcug.org 
actuary110 (at) yahoo.com 
 
I was given an Accuvoice V100 M "Mini" TV Speaker for review. It is a product made by the ZVOX compa-
ny. 
 
It is an addition for your TV, smart or otherwise. It is smaller than the sound bars I've seen in retail stores, 
and it fits nicely below my TV, beside my Dish controller. 
 
The kit comes with a remote (yet another one!) with five buttons: power, sound up and down, mute, and Ac-
cuvoice. That last button has a remarkable ability to increase voice when a program has both music and 
voice, and it is hard to hear the voice. In addition, there are six levels of music suppression, so you can get 
more voice and less music when you want it. 

 
 
I've never seen this feature on any other device, but it may become more popular as users realize that such a 
device is available. 
The kit also has several connectors. Only one is used, but you must refer to the brief manual to determine 
which one to use to connect to your TV set. I had some trouble with this and had to call their support to get 
the job done. Support was extremely helpful and very patient. 
 
The soundbar includes its own speakers, which are a bit better than my TV's speakers. 
 
My Dish remote turns on both my TV and the Dish controller. The ZVOX's remote turns on the soundbar. 
Two LEDs let you know what the status is. One is blue, which indicates power on, volume down, or mute, 
and the other is amber, which indicates volume up. When you push Accuvoice, the blue LED shows briefly. 
 
A standard power cord and plug power the soundbar. The sound bar's dimensions are 10" X 2.5" X 3". 
 
The company provides free shipping and a 60-day free home trial. In addition, the product has a one-year 
parts and labor warranty. 
 
I'm very satisfied with this product. It provides a measure of relief for those situations where the program's 
voice is nearly unintelligible because of the overriding music or other background sound. 
 
ACCUVOICE AV100 "MINI" TV SPEAKER 
 
https://zvox.com/collections/accuvoice/products/av100-accuvoice-speaker 
 
Price $100 
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Plateau PC Users Group, Inc.  
 

 Revised Application for Membership for 2021 
   
            ------- New Member    ------ Renewing Member 
 
Return this application with check foe annual dues payable to “PLATEAU PC USERS GROUP” Return to 
the club Treasurer during our meeting or mail to “PPCUG Treasurer. P.O. Box 3787, Crossville TN  38557” 
 
Our annual dues are now payable July 1st. of each fiscal year.   
Persons// families joining during the fiscal year have dues payable as follows: 
 

 
 
Date: --------------------               Amount Paid: $ --------------------   by Cash ------ , or Check (# ----------------------- ) 
 
--------------------------          -------------------------      -------------------------------------------- 
Last Name   First Name  Family Member (if family membership) 
 
------------------------------------------------------------------------------- 
Address: 
 
--------------------------------------        --------           ---------------    (-------------) ----------------------------- 
City     State  Zip Code Phone Number 
 
E-Mail address: ---------------------------------------------------------------------- 
    Please Print 
 
I have belonged to a Computer Club before:  Yes -----------     No ------------  
 
I have used PC’s since (year): ------------------  
 
I have knowledge in the following areas that I would be willing to share with club members: 
 

 
 

 
 

 
Note: Dues are now back to pre COVID-19 time, and due by July 1st 

 
July 2021 

 Join In July - Sept Oct - Dec Jan - Mar Apr - June 

Single $24 $18 $12 $6 

Family $30 $22 $15 $7 
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March 2022 

Sun Mon Tue Wed Thu Fri Sat 

  1 2 2:00 P.M. 

PPCUG 
Board Mtg. 

3 4 5 

6 7 8 3:00 P.M. 
General Mtg. 
Presentation.  
Followed by 
Q&A Session 

9 10 11 12 

13 14 15 16 17 18 19 

20 21 22 23 24 25 26 

27 28 29 30 31   

This Photo by 

https://gsouto-digitalteacher.blogspot.com/2018/03/schools-daylight-saving-time-oops.html

